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Chapter 1: Introduction

Studio Monitor Express (SME) is a powerful and flexible audio monitoring software application that runs on your workstation or 
a dedicated computer and controls the routing between applications, external inputs, and ASIO hardware. 

SME is a software version of a typical mixing console’s master and communications section and provides a professional surround 
sound monitor mixer with two 5.1-speaker outputs and one stereo output (each with level, cut, and talkback controls). SME out-
puts are routed to the audio I/O hardware and can be controlled from the monitor section on Artist Series media controllers. SME 
can also listen to external inputs without another application open.

Be aware that Studio Monitor Express does use additional CPU resources beyond EuControl, so if you do not require these ad-
vanced features (or your audio interface software already provides this functionality), there is no need to install SME.

SME is included as a separate installer on the EuControl CD-ROM that shipped with your unit. It includes a Euphonix Monitor 
Core Audio Driver (Mac) and ASIO driver (Windows) to integrate with applications you want to use with SME.
System Requirements and Compatibility
Avid can only assure compatibility and provide support for hardware and software it has tested and approved. 

For downloads and other Artist Series resources, visit: 

www.avid.com/artistsupport

About This Guide

Conventions Used in This Guide

All of our guides use the following conventions to indicate menu choices and key commands:
:

Mac and Windows versions of SME are not identical. Whenever their appearance or functionality differ, this guide documents both 
(any sections that do not specify Mac or Windows are effectively the same on both platforms). 
The names of Commands, Options, and Settings that appear on-screen are in a different font.

The names of keys on Artist Series hardware are in bold (such as SHIFT and SEL). Do not confuse the SHIFT key on Artist Series 
hardware with the Shift key on your computer keyboard. 

Convention Action

File > Save Choose Save from the File menu

Control+N Hold down the Control key and press the N key

Control-click Hold down the Control key and click the mouse button

Right-click Click with the right mouse button
Chapter 1: Introduction 1



The following symbols are used to highlight important information:
Studio Monitor Express2
User Tips are helpful hints for getting the most from your system.
Important Notices include information that could affect your data or the performance of your system.
Shortcuts show you useful keyboard or mouse shortcuts.
How to Use this PDF Guide

The Acrobat PDF version of this manual can be a valuable online resource. These are some useful features of the PDF:

• The Bookmarks on the left serve as a continuously visible table of contents. Click on a subject heading to jump to that page. 
Click a + symbol to expand that heading to show subheadings. Click the – symbol to collapse a subheading.

• The Table of Contents provides active links to their pages. Select the hand cursor, allow it to hover over the heading until 
it turns into a finger. Then click to locate to that subject and page.

• All cross references are active links. Allow the hand cursor to hover over the reference until it turns into a finger and click 
to follow the reference.

• Select Find from the Edit menu to search for a subject.

About www.avid.com
The Avid website (www.avid.com) is your best online source for information to help you get the most out of your system. The 
following are just a few of the services and features available. 

Product Registration

Register your purchase online. 

Support and Downloads

Contact Avid Customer Success (technical support); download software updates and the latest online manuals; browse the Com-
patibility documents for system requirements; search the online Knowledge Base or join the worldwide Pro Tools community on 
the User Conference. 

Training and Education

Study on your own using courses available online or find out how you can learn in a classroom setting at a certified Pro Tools 
training center. 

Products and Developers

Learn about Avid products; download demo software or learn about our Development Partners and their plug-ins, applications, 
and hardware. 

News and Events

Get the latest news from Avid or sign up for a Pro Tools demo.

Cross References point to related sections in this guide and other Avid guides.



Chapter 2: Installing Studio Monitor Express

SME is included as a separate installer on the EuControl CD-ROM included with your unit. It includes Mac and Windows audio 
drivers to integrate applications you want to use with SME.

Installation

To install Studio Monitor Express:

1  Do one of the following:

• Download the most recent EuControl installer for your computer platform from www.avid.com. After downloading, make 
sure the installer is uncompressed (.dmg on Mac or.ZIP on Windows). 

– or –

• Insert the Installer disc into your computer. 

2  Double-click the Studio Monitor Express installer application, located inside the Extras folder.

3  Follow the on-screen instructions to complete the installation.

4  When installation is complete, click Quit (Mac) or Finish (Windows).

Removing Studio Monitor Express
If you need to remove SME from your system, follow the instructions below for your computer platform.

Mac OS X

To remove SME:

1  Make sure you are logged in as an Administrator for the account where SME is installed. 

2  Go to Applications/Euphonix and double-click Uninstall Studio Monitor Express.

3  Click Yes to proceed with the uninstall. 
4  Enter your Administrator password and click OK. 

5  Click Close to close the Uninstaller window. 
Chapter 2: Installing Studio Monitor Express 3



Windows Vista and Windows 7

To remove SME:

1  Choose Start > Control Panel.

2  Under Programs, click Uninstall a program. 

3  Select Studio Monitor Express from the list of installed applications.

4  Click the Change button.

5  Select the Modify button.

6  Click Next.

7  Deselect Studio Monitor Express.

8  Click Next.

9  Follow the on-screen instructions to complete the removal. 
Studio Monitor Express4



Chapter 3: Using Studio Monitor Express

Studio Monitor Express provides several tabs in which you patch and configure audio between SME and your workstation. Once 
configured, SME lets you switch between multiple speaker setups, mute and dim monitor outputs, listen to and control external 
sources (such as a CD player), and utilize Talkback. 

When the workstation and Artist device are connected, changes made in either the Main tab or on an Artist surface are reflected 
in the other.

Main
The Main tab provides sliders, settings, and a Source display for three available monitor outputs: Control Room, Monitor A, and 
Monitor B. 
Main tab
Source
Maps Sources created in the Sources tab to Control Room, Monitor A and B. 

To route a Source to a specific Monitor section:

Select a source in the Source box for the desired monitor output. Sources can also be selected from the Artist Control’s Control 
Room and Monitor Setup Touchscreens. Only sections created in the Sources tab appear in the Source boxes. (See “Sources” on 
page 6.)

This is also selectable from the Artist Control Monitor Touchscreen.
Control Room, Monitor A and B Level
These sliders control the level of Control Room, Monitor A and B, respectively. Correlates to the CONTROL ROOM/MONITOR knob 
in the Artist Control’s Monitors section. 
Chapter 3: Using Studio Monitor Express 5



To set the level for the Control Room output: 

 Turn the CONTROL ROOM/MONITOR knob. 

To set level for Monitor A:

 Hold down a Function key and then turn the CONTROL ROOM/MONITOR knob. 
To set level for Monitor B:
Studio Monitor Express6
 Adjust the Monitor B slider in the SME Main tab (Monitor B can be controlled only on-screen with a mouse). 
Cut
Cuts the signal completely.
Dim
Attenuates the signal to the Dim Level set in the Config tab (page 13).
Fix
Sets the signal to the Fixed Level set on the Config tab (correlates to the Dim button in Artist Control Setup > Control Room Touch-
screen).
Phase
Reverses the phase of the left channel in the Control Room outputs only. Phase is only available on-screen.

Sources
The Sources tab is where you create the sources to SME mixer inputs to make them available in the Main tab. 

To create a source:

1  Select the Format (Mono, Stereo, or 5.1). 

2  Select the Start Channel (the channel where you want the first, or left-most, source channel to be routed). Choices are slightly 
different on Mac than on Windows as follows: 

Sources tab



Mac 

On Mac, Channels 1–8 are used for internal busses from the application using the Studio Monitor Core Audio driver. Channels 
9–16 are reserved for external, physical inputs (physical inputs to the audio I/O, such as an external CD player connected to the 
sound card inputs).

Windows

On Windows, any of the available 16 channels can be inputs or outputs. 
To create inputs or outputs on Windows:

1  Type a name into the Name field.
2  Click Create. 

SME creates the input monitoring section and adds it to the list of sections on the Main tab. It is now available for monitoring. 

To route stereo audio from a Mac application into SME:

1  Select Euphonix Monitor as the application’s Core Audio output driver. 

2  In the SME Sources tab, do all of the following: 

• Create a Stereo source. 

• Name it for the application (such as Nuendo). 

• On Mac (only) Set the Start Channel to 1. This creates a stereo monitoring source for SME mixer input channels 1 and 2. 

3  Enable the source in the SME Main tab or from the Artist Control’s Monitor or Control Room Setup Touchscreens.

To create a source for a stereo external, physical input (such as a CD Player): 

1  Select Stereo from the Format menu.

2  Set the Start Channel by doing either of the following: 

• On Mac, select 9 from the Start Channel menu.

• On Windows, select 1. 

3  Type “CD Player” in the Name field.

4  Click Create. 

In this example, SME creates a stereo monitoring section for its input channels 9 and 10 (Mac) or 1 and 2 (Windows). 

The inputs to that SME monitoring section are defined in the Patching tab (Mac) or Hardware I/P patching tab (Windows). For 
more information, see “Patching” on page 8.
Chapter 3: Using Studio Monitor Express 7



Patching
The Patching tab routes audio between your applications and audio hardware that uses Euphonix Monitor Core Audio (Mac) or 
ASIO (Windows). The appearance of the Patching tab differs depending on whether you are using Mac or Windows. 

See “Mac Patching Tab” on page 8, or “Windows Patching Tab” on page 9. 
Mac Patching Tab
Studio Monitor Express8
On Mac, a single Patching tab provides access to all routing controls in a single, consolidated window. 
The Patching tab lets you route SME inputs from external hardware inputs as well as from applications that use the Euphonix 
Monitor Core Audio driver (Mac), and route SME outputs to hardware outputs. 

Patching tab (Mac)
Inputs
The Inputs section has eight selectable inputs from the application’s outputs (Application Out), and eight selectable inputs from 
hardware inputs (Audio Device In) installed in your workstation. Each application used with SME must use the Euphonix Monitor 
Core Audio driver.
Outputs
The Outputs section routes audio device outputs to the Main, Alt 1, Alt 2, Monitor A, and Monitor B outputs available in SME. Use 
these selectors to assign monitor channels for main and alternate speakers, cue mix feeds for headphones, and other output des-
tinations. 

You can also use these controls as a virtual patchbay. For example, to change a 5.1 output from L-C-R-Ls-Rs-LFE to 
L-R-Ls-Rs-C-LFE, change the output routing using the pop-up menus in the Output section in SME instead of physically repatching 
the outputs to your monitors.



Windows Patching Tab
On Windows, the Patching features are grouped into sub-tabs: SME O/P Patch, Application O/P Patch, and Hardware I/P Patch.
Left to right, SME O/P, Application O/P, and Hardware I/P tabs (Windows)
SME O/P Patch
The SME O/P Patch tab routes the assigned SME Monitor outputs to audio I/O hardware. Select the desired outputs from the Hard-
ware O/P drop-down menus.
Application O/P Patch
The Application O/P Patch tab routes application outputs (such as output channels from Nuendo) to hardware outputs and/or SME 
Inputs.

• The Hardware O/P drop-down lets applications using the SME ASIO driver route signal directly to physical outputs (bypassing 
SME).

• The SME I/P drop-down lets applications using the SME ASIO driver route signal into the SME mixer. It is possible to select 
both a Hardware output and SME Input simultaneously, creating a mult.
Use these selectors to assign monitor channels for main and alternate speakers, cue mix feeds for headphones, and other output 
destinations. If the main outputs from your DAW application are Hardware O/Ps 1–6, they would typically be routed to SME O/Ps 
1–6. However, it is also possible to route the speaker outs to a different order (such as SMPTE format) than your monitors. 

You can also use these controls as a virtual pathbay. For example, to change the layout (format) of a 5.1 output from 
L-C-R-Ls-Rs-LFE to L-R-Ls-Rs-C-LFE, change the output routing using the pop-up menus in the Patching tab in SME instead of 
physically repatching the outputs to your monitors.

Hardware I/P Patch

The Hardware I/P Patch tab routes audio from the hardware inputs (Hardware I/P) on your workstation sound card to the Appli-
cation I/P and/or inputs of SME’s mixer inputs (SME I/P).

To pass audio from a physical input to an application, the hardware inputs (Hardware I/P) must be patched to Application I/P in-
puts. We recommend a one-to-one patch to make it easier to track the mapping between physical inputs and channel inputs in 
your DAW. However, it is possible to re-route a hardware input to a different input. For example, if the kick drum is on the 24th 
physical input and you want it to appear to your DAW that it’s on the 1st input, select 1 from the Hardware I/P 24’s Application 
I/P pop-up menu.

Here is another example. If a CD player is routed to hardware inputs 40 and 41, select 1 and 2 from the Hardware I/P 40 and 41 
SME I/P dropdown menus respectively. This routes the CD player to Mixer inputs 1 and 2. For steps to create stereo mixer inputs 
in the Sources tab, see “Sources” on page 6.

Only outputs enabled in the Config tab are available from the Hardware O/P and SME I/P drop-down menus.
Only outputs enabled in the Config tab are available from the Application I/P and SME I/P drop-down menus (For more informa-
tion, see “Config” on page 11). SME minimizes its CPU resources if you enable only the inputs you plan to use. 
Chapter 3: Using Studio Monitor Express 9



Speakers
Studio Monitor Express10
The Speakers tab attenuates and mutes output levels. Each monitoring section has its own controls:

Control Room Main, Alt1, Alt2

Monitors A and B

To lower (trim) speaker levels: 

 Drag the corresponding faders to the left. Level is displayed in the Trim field to the right of the fader. Double-click the Trim field 
to enter a numeric value.

To mute speaker output: 

 Click a Cut button to mute that output. 

Speakers tab



Config
The Config tab shows the current audio driver, and provides level controls for Dim and Fixed. The Config tab is slightly different 
depending on whether you are using Mac or Windows. 

For Mac, see “Mac Config Tab” on page 11; for Windows, see “Windows Config Tab” on page 12.
Mac Config Tab
On Mac, the Config tab displays the currently selected Core Audio device driver and lets you set Dim and Fixed output levels.
Audio Device

This menu selects the Core Audio driver for the sound card to use with SME.

Set Dim Level

Sets the program signal’s absolute Dim Level when the Control Room Setup Touchscreen’s Dim button is active.

Set Fixed Level

Sets a fixed output level for the Control Room output. This is useful for sending the DAW output to a separate mixer or router 
that has its own level controls, instead of controlling the output level from SME.

When the output driver is changed, patching is reset to default settings with no external or output patches enabled. Patches must 
be reassigned in the Patching tab.

Config tab (Mac)
Chapter 3: Using Studio Monitor Express 11



Windows Config Tab
Studio Monitor Express12
The Config tab on Windows lets you set levels for Dim and Fixed outputs, lets you enable  hardware inputs and outputs that patch 
to sources and destinations, and displays diagnostic information. 
Config tab (Windows)
Set Dim Level
This sets the attenuation amount (in dB) for the program signal when using the talkback function.
Set Fixed Level
This sets the fixed output level, which is selectable in the Main tab for the Control Room output. This is useful for setups that have 
been calibrated to a specific reference level and must maintain a fixed output level.
CPU Usage
This meter shows SME CPU usage.
Sample Rate
This shows the current sample rate to which SME is locked. This is only an indicator since the sample rate is determined by your 
sound card’s settings.
Settings
This enables saving the current settings or loading previous settings, to quickly switch between different SME configurations.
Enable Hardware Ports
This lets you explicitly enable or disable each SME port. This limits the ASIO stream inputs and outputs monitored by SME, thus 
minimizing traffic on the audio bus to only those ports necessary for the current setup. Only ports enabled here are available for 
routing on the other SME tabs (such as Main and Sources).



Enabling and Configuring Talkback 

To enable and use a talkback mic:

1  Connect a microphone to a mic preamp, and connect the preamp output to an input on your audio interface. Set the input gain 
as appropriate. 

2  In the SME Patching tab, assign the Audio Device In to the I/O channel to which you connected your mic preamp.

3  In the SME Sources tab, create and name a Source for Talkback.

4  In the Main Tab, click to enable Talkback for each section requiring talkback routing (Mon A, Mon B).

5  In the SME Main Tab, click the Talkback button to enable Talkback.

6  Press the Artist Control Talkback button in the Setup Page of the Soft Keys to engage Talkback.
Chapter 3: Using Studio Monitor Express 13
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